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MagBytes; the fine print 
This is a free New Zealand subscriber email info magazine from the NZ Apple news and info site mac-nz.com.
MagBytes tells you what’s happening and what’s new in the world of Apple every month, compiled from Mac NZ. 
Learn tips and how to do interesting things with your Macs and iDevices, and how to get more out of them. 
MagBytes is brought to you by Mark Webster, onetime editor of NZ Macguide magazine and a long-time trainer and commentator on Apple and the world of technology. 
Mark wrote about Apple for a worldwide audience on the New Zealand Herald under the title ‘Apple Watch’ (2009-2014) and at his Mac NZ Apple info site for New Zealand. You can store 
your issues of MagBytes on your HD, Thumb Drive or on CD/DVD, read it on screen, or even just drag it to iTunes (or to iBooks, from macOS 10 Mavericks onwards, which means you end up 
with a reference library you can search, highlight, add notes to etc) and have it appear on your iPhone and iPad (inside iBooks) next time you sync. Or print it out, even – and please feel free 
to pass MagBytes on. MagBytes is free to receive; recipients details are not shared with, or available to, anybody except me.  
Find out more about the MagBytes Apple newsletter online (click on ‘MagBytes Newsletter’ at top right).

September 2017  
•2——Mac News ~ Steve Job 

Theater, Mexico, iTunes movies, 
DACA, Jackson, Mac games 

•4——Updates ~ Pages, Numbers, 
Keynote, watchOS 4, iOS 11, Apple 

TV 4K, macOS High Sierra 
•6——Mac Help ~  

Around New Zealand 
•7—— iOS & iDevice news ~ 

iPhone 8 & X, Aii Bionic, Watch 
Series 3, wireless charging 

•9——Apple & Talk ~ iPhone X will 
be here one day –  

for those who can afford it 
•10——Tips & Tricks ~ iOS 11 – 

but also 10, and macOS,  
& even a couple for Watch  

•16——Shiny & New ~  
Kensington SD5000T Dock,  

Belkin Thunderbolt 3 Express dock  
& Nanoleaf  Aurora

Monthly NZ newsletter of  things Apple for your edification and delectationMagBytes

Apple did announce ‘iPhone 8 ‘but also iPhone X! iPhone 8 has the same CPU and shares other advances, but it’s available now, 
whereas the X (‘10’) is still month away.(Image from Apple NZ’s iPhone 8 Page)

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://www.creativetech.net.nz
http://www.mac-nz.com
http://www.mac-nz.com
http://www.mac-nz.com
https://www.apple.com/iphone-x/
https://www.apple.com/nz/iphone-8/
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Mac News > The new Steve Jobs Theater makes a statement about Apple

‘Intriguing’ Steve Jobs Theater
Author Cybart had a close-up look at the Steve Jobs Theater when he 
attended Apple’s September 12 event. His very detailed and revealing 
article includes photos from Apple and himself as well as a side-view 
schematic of the underground layout.
It’s immediately clear that there is much more at stake here than 
an attractive theatre. Namely, it’s not, anymore, exclusively about 
Apple products but rather Apple as a product. Understanding that 
is key to understanding the company itself as a brand and a product, 
and that leads to a better understanding of what Apple is all about. 
This is an excellent article, full of insights.

More news is online at Mac NZ

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.macobserver.com/columns-opinions/particle-debris/design-of-steve-jobs-theater/
https://www.macobserver.com/columns-opinions/particle-debris/design-of-steve-jobs-theater/
http://www.mac-nz.com
http://www.istorenz.com
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Mac News > Million for Mexican recovery, Cook & Jackson comment, Mac games

More news is online at Mac NZ

Apple million for Mexico
In a Twitter post, Apple CEO Tim Cook 
says the company is donating US$1 million 
toward earthquake recovery efforts in 
Mexico. 
The company has also donated to 
hurricane recovery efforts in Texas and 
Florida. 

iTunes movie rental extended
To coincide with the launch of Apple TV 
4K and iPhone 8 series, Apple has recently 
updated its website with new information 
regarding movie rentals, saying viewers 
now have up to 48 hours to complete their 
rented titles after first pressing play.

Tim Cook’s DACA language 
Apple CEO Tim Cook reiterated his stance 
against DACA’s elimination in what is 
possibly his most candid and firmest 
statement on the matter since he first 
spoke on the matter.
“This is unacceptable, this is not who 
we are as a country,” Cook said at the 
Bloomberg Global Business Forum 
on Wednesday morning regarding the 
Deferred Action for Childhood Arrivals 
(DACA) executive order’s pending 
elimination. “I am personally shocked that 
there’s even a discussion on this. It’s not a 
political thing, at least I don’t see it that 
way at all. It’s about basic human decency 
and respect.”

Lisa Jackson criticises Trump
Apple VP of Environment, Policy and Social 
Initiatives Lisa Jackson in an interview on 
Tuesday said the Environmental Protection 
Agency, which she led from 2009 to 2013, 
is under threat from President Trump’s 
administration for a seeming lack of 
transparency.

Future Mac games
Sometimes, there are simply too many 
Mac games to cover! 
Here’s an overview of the most exciting 
Mac games discovered recently, like 
SteamWorld Dig 2, a platform mining 
adventure, and  Pillars of Eternity II 
(below).

mailto:mac.nz%40me.com?subject=From%20MagBytes
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http://www.mac-nz.com
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http://appleinsider.com/articles/17/09/20/tim-cook-issues-strongest-language-yet-regarding-daca-supporting-dreamers
http://appleinsider.com/articles/17/09/20/tim-cook-issues-strongest-language-yet-regarding-daca-supporting-dreamers
http://appleinsider.com/articles/17/09/19/apples-lisa-jackson-criticizes-trump-epa-for-lack-of-transparency
http://appleinsider.com/articles/17/09/19/apples-lisa-jackson-criticizes-trump-epa-for-lack-of-transparency
https://www.appleworld.today/blog/2017/9/19/the-future-mac-games-that-have-me-excited
https://www.appleworld.today/blog/2017/9/19/the-future-mac-games-that-have-me-excited


‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2017. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip 
Enterprises 
2010-2017.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission, 
please   
email 
Mac NZ 

Mac NZ

>>

>
>

page 

4
MagBytes

#91

Pages, Numbers, Keynote with iOS 11 features 
Following Tuesday’s release of iOS 11, Apple has updated its iWork 
suite of productivity apps to better take advantage of the new 
operating system’s features, with iPad-centric support for drag 
and drop, multitasking and more. 
Pages has a redesigned document manager for streamlined 
access to files stores in iCloud Drive and third-party cloud service 
providers. The word processor is also compatible with the new 
Files app, a central hub for local and cloud-based documents, 
images and more.
Apple’s Numbers receives many of the same iOS 11 changes 
with support for drag and drop, multitasking and the new Files 
app. Numbers also benefits from unspecified performance and 
stability improvements.
Apple’s Keynote update focuses on basic iOS 11 compatibility, 
with release notes for the software mentioning the redesigned 
document manager, drag and drop, multitasking and support for 
the Files app. Keynote touts new shape and object commands, 
and performance and stability improvements. 

Safari 11 update for macOS Sierra & El Capitan
Though included by default with the upcoming macOS High 
Sierra, Apple first released Safari 11 for macOS Sierra and OS X El 
Capitan, giving people early access to new features.

watchOS 4 for Apple Watch
The Apple Watch interface has been refined and improved with 
today’s launch of watchOS 4, including a new vertically scrolling 
app dock, the ability to view installed apps in a list view instead 
of grid, and new watch faces including a Siri smart assistant and 
characters from the iconic Toy Story films.

Updates > Pages, Numbers & Keynote, Safari, watchOS 4, iOS 11, TV, High Sierra

Inside iOS 11
iOS 11 rocketed to over 65 of internet usage in just two days 
after launch, according to independent web analytics company 
StatCounter. StatCounter Global Stats found iOS 11 reached 6.2% 
of all iOS versions worldwide in two days. iOS 11 has some big 
changes for iPhone and iPad users, one of which involves photos 
we take thanks to HEIF, an image format supported by both iOS 11 
and macOS High Sierra.In older versions of the operating system 
our photos were saved as JPEG, but in iOS 11 they’re saved as HEIF.

Apple TV 4K with tweaked Siri remote design
If you owned the previous 4th-gen Apple TV with Siri remote, 
you’ll be hard pressed to find any differences with the new 5-gen 
Apple TV 4K, aside from a white, raised ring on the remote’s 
Menu button. [The new Apple TV starts at NZ$299 and there’s 
also a tvOS update.]

Apple releases macOS 10.13 High Sierra
High Sierra has arrived for all users and brings the Apple File 
System to the Mac for the first time , while introducing support 
for a variety of other standards such as HEVC video, HEIF image 
encoding, and Apple’s Metal 2 graphics platform supporting 
technology like external GPUs. Just look in the Mac App store 
under Updates. 
Apple has not put any more limits on High Sierra than already 
existed on Sierra. However, High Sierra is the last version of 
macOS to support 32-bit apps “without compromises.”
Another new features is a new routine in High Sierra runs 
automatically weekly and checks the firmware of the Mac that is 
installed on to check for modifications that may jeopardize the 
security of the machine.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
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http://appleinsider.com/articles/17/09/19/apple-issues-safari-11-update-for-macos-sierra-os-x-el-capitan
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USB-C to USB Cable
Power and charge any USB-C device (ie, MacBook, late 2016 
MacBook Pro) using a regular USB charger. Supports USB 3.1 
Gen 1 data transfer speeds of up to 5 Gbps, Moshi’s USB-C 
to USB Cable is encased in aluminium with reinforced stress 
relief points and includes a HandyStrap cable manager
NZ RRP$44.99

IonGlass for 
iPhone 7
IonGlass is an atomically-
strengthened glass screen 
protector featuring 
smooth, edge-to-edge 
protection with a micro-
bevel around the Home 
button for fast unlocking 
via Touch ID. Its exceptional 
hardness exceeds that of 
steel. 
NZ RRP$59.99 
(iPhone 7 Plus, NZ$69.99)

USB-C to VGA adapter
Output HD video from any USB-C device or laptop 
to a VGA display or projector. Moshi’s VGA adapter 
supports video resolution up to 1920 x 1200/1080p 
at 60Hz. Both ends of the cable are encased in 
anodised aluminium to minimise electromagnetic 
interference. With its reversible USB-C connector 
and plug-n-play capability, the adapter guarantees 
a hassle-free setup for convenient home or office 
use
NZ RRP$69.99

USB-C Charge Cable
Smart LED indicators keep track of your charging 
status. Supporting up to 60 Watts of power output 
and USB 2 data transfer speeds, Moshi’s USB-C 
Charge Cable has durable aluminium housings and 
delivers utility and style for anyone with a USB-C 
MacBook. At 2 metres length (6.6 feet) in length, a 
HandyStrap is also included to keep your cable tidy 
during transport. NZ RRP$59.99

armour for  
iPhone 6-7
The armour features a 
diamond-cut aluminium 
backplate with a unique 
metallic finish, the 
hybrid material has 
shock absorption and is 
scratch resistant. It has 
fully-encased volume and 
power buttons and the 
raised bezel protects the 
display and the case offers 
military-grade drop-
protection (MIL-STD-810G, 
SGS-certified)
NZ RRP$64.99

Symbus Compact USB-C Dock
Moshi’s Symbus is a compact USB-C dock that turns your 
laptop into a desktop system with one cable. Symbus 
connects your MacBook or USB-C laptop to an HDMI 
monitor, wired internet and 2 USB peripherals such as a 
keyboard, mouse or external storage. The dock supports  
4K video outputs and digital surround sound to HDMI-
equipped displays, AV receivers, or projectors and can 
charge the MacBook and 13-inch MacBook Pro. 
NZ RRP $269.99 (US$124.95)

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
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Apple support & AppleCare
Apple’s official support pages are 
comprehensive and cover all aspects of 
Apple hardware and software – it’s here.
Also try Intro to the Mac and How Tos.
AppleCare: If you need your Mac fixed, 
look for an Apple licenced repair centre. 
People often ask me if they should buy 
AppleCare with their devices. Every new 
Mac has a one-year warranty and 90 days 
free phone support. AppleCare extends 
this all out to three years. Under NZ 
law, you are covered by the Consumer 
Guarantees Act against anything going 
wrong that comes down to parts failure 
within reasonable expectations (say, inside 
three years’ use), but be prepared to spend 
anxious time on the phone, sticking to 
your guns to get it fixed. 
However, this absolutely does pay off.
AppleCare is expensive, depending on the 
device, but it’s a replacement policy which 
covers you anywhere in the world. 
If you travel and you want full reassurance, 
and you can afford it, AppleCare is superb.

Mac Senior Net — ready to help
If you are aged 55 years or better and you 
use an Apple computer or device, Mac 
Senior Net is a wonderful resource.

Christchurch: With nearly 600 
members, this very active Apple-
focussed group covers Christchurch with 
a dedicated lab – and caters to the city’s 
surrounds by running iPad sessions in 
rest homes. This is a large, well-run and 
successful group.
 
Auckland: Mac Senior Net Auckland 
provides on-going Apple Mac and iDevice 
knowledge to help competency, learnt 
alongside others in similar situations. 
The Auckland Club holds monthly 
meetings in Howick, Bayswater and 
Remuera and provides lessons and talks 
very reasonably. Go to MSN Ak’s web page 
or email Marion Moffat.
Handy Absolute Beginners’ courses are also 
available at SeniorNet, including for iPads.
Eden Roskill — This Auckland branch has 
an Apple Group that meets on the second 
Monday of every month at 487 Dominion 
Rd in the Mt Eden Senior Citizen Rooms, 
opposite Potter’s Park in Balmoral. There 
are several courses for Apple users (Mac, 
iPhone and iPad) as numbers warrant. To 
join, call Janet 09 828 3098

Mac diagnostics
Your Mac has various diagnostic tools and 
routines available. If you think things are 
going awry, check the Help page on Mac 
NZ (click on Help at the top), but the first 
thing you can do is open the Utilities folder 
on your Mac’s applications folder, and find 
Apple’s Disk Utility (that’s its icon, above). 
Launch it, select your Mac’s internal hard 
drive which is normally called ‘Mac HD’ 
(or choose any plugged in hard drive/flash 
drive/camera card etc) and run First Aid 
over it. (iDevices are another story!)

Mac help in the North 
Dave Boswell has been a reseller in 
Whangarei for 20 years and can assist. 
Contact MacNorth Computers 09 433 
9855, 027 490 2332, or email Dave 
Boswell.

Mac Help > Apple diagnostics, Consumer Guarantees Act, help, support

Papakura — Mac Interest Group meets 
every 1st, 3rd and 4th week of the month 
9.30 to Noon. An iPad Interest Group 
meets every 3rd Tuesday at 1pm
An “Introduction to iPad” course run on 
demand.

mailto:mac.nz%40me.com?subject=From%20MagBytes
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iDevice news

Logitech ad

iPhone X
On the 10th anniversary of the 
original iPhone, Apple unveiled 
the highly anticipated iPhone X 
(pronounced ‘ten,’ not ‘ex’). The 
glass-encased, almost bezel-less 
smartphone unlocks with facial 
recognition technology and charges 
wirelessly. 
With the basic model starting 
at NZ$1799/US$999, it’s also the 
most expensive iPhone ever. Is the 
iPhone X a game-changer or just a 
very expensive, very sleek-looking 
pocket computer? Here’s what tech 
writers are saying after spending a 
little bit of hands-on time with the 
iPhone X at Apple’s event. iPhone 
X (10) will not be available until 
November.

A11 Bionic processors
Apple has brought design and 
development of the A11 Bionic 
processor even more in-house 
with the eradication of outside 
solutions, allowing the company to 
speed up and further integrate the 
new chip’s various processes more 
than it ever has before. The effort 
appears to have paid off, from a 
raw performance perspective. Early 

> iPhone X uses A11 Bionic chip by Apple (as does iPhone 8)

More news is online at Mac NZ

mailto:mac.nz%40me.com?subject=From%20MagBytes
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iDevice news> iPhone 8, Apple Watch Series 3, wireless charging

benchmarks of devices purporting to use 
the new chip test the A11 Bionic as notably 
faster in every regard than the processor 
found in the Samsung Galaxy S8 and Note 
8. This new CPU has also allowed Apple to 
go all-in on augmented reality.
Apple’s new A11 Bionic chip used in iPhone 
8 and the upcoming iPhone X packs in an 
array of processing cores and sophisticated 
controllers, each optimised for specific 
tasks. We only know a bit about these, 
let alone what else is packed into this 
SoC. Here’s a look at the new Apple GPU, 
Neural Engine, its 6-core CPU, NVMe SSD 
controller and new custom video encoder 
inside the package.

iPhone 8 is available
It’s here in New Zealand, available to buy. 
As Apple says, it has “The most durable 
glass ever in a smartphone, front and 
back. A colour-matched, aerospace-grade 
aluminium band. New space grey, silver 
and gold finishes.”
You can buy it from the usual places or 
direct from Apple,  (call 0800-692-7753).
If you get to get rid of your old iPhone in 
favour of a new one, here’s how. If you’d 
rather wait for the break-the-bank iPhone 
X, Mujo already has bespoke leather cases 
ready for them.

iPhone 8 smaller batteries
Apple has actually shrunk the batteries 
in the iPhone 8 and 8 Plus compared to 
their predecessors while maintaining the 
same longevity, filings with the Chinese 
government show. Here are the differences 
between the two 8 models (other than 
size).

Apple Watch Series 3
The W2 chip in Apple Watch Series 3 
boosts wireless speeds while maintaining 
battery life. T
he W2 is a new self-designed wireless chip 
that’s nominally the successor to the W1 
found in audio accessories like AirPods and 
the Powerbeats3. But what advantages 
does it offer, and why is it in a watch 
instead?
Apple launches watchOS 4 for Apple 

iPhone 8 wireless charging
iPhone 8 recharges via inductive wireless 
technology at a rate comparable to the 
standard 5-watt charger that ships with 
the handset. 
But Apple plans to improve that speed 
with a future software update.
This video shows everything you need to 
know about Apple’s iPhone 8 and iPhone 
8 Plus,

More news is online at Mac NZ

iPhone X (pronounced 10, not X)  was bound to be 
controversial as it’s so expensive, so big and so 
unavailable for a while yet, plus has that dark bit
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apple&talk > iPhone 10 or iPhone X? 

Is an X sexier than a 10? It’s bolder-
looking, anyhow, but begs being expressed 
as ‘Ex’ instead of ‘ten’. I remember how 
uncomfortable Apple used to be about 
people saying ‘Oh Ess Ex’ (just say it a 
couple of times) yet they persisted, I 
wondered if changing the nomenclature 
to ‘macOS X’ was a part of the gradually 
persuasive campaign to get people to 
pronounce it as ‘macOS Ten’ instead (it 
used to just be ‘OS X’, but then iOS and 
watchOS became big players).

And should you wait for an iPhone X 
or spring for an 8? They have many of 
the same features, Personally, I don’t like 
phablets as they’re simply too big for the 
pocket, so the 8 is the natural choice for me 
for three reasons: it’s cheaper, it’s smaller 
and it’s available now.
I still have an iPhone 6. I bought it three 
years ago. I took all the pictures in my 
latest book with it. It’s getting a little 
shoddy but it still performs perfectly well 
and I like the slim form factor (virtually 
the same as the 8). If I can hang on till 
the iPhone 8s, I will, but it may not last 
that long. The iPhone 8 is a wonderful 
phone with an Apple-developed A11 Bionic 
CPU that blitzes the chips from all them 
other smartphone makers. That’s pretty 
compelling, although I have to admit, 

since I don’t play games on my iPhone, 
the camera advances are likely to be 
more useful to me. I have noticed my 6 
processing photos quite slowly these days, 
so I will definitely appreciate more core-
power.
Apple is using the new A11 Bionic in its 
iPhone 8/8 Plus models but it’s the same as 
that in the iPhone X. The scores Geekbench 
outlines for the three models show some 
variation between them (less than 5% in 
single core and around 7% in multicore), 
likely related to the difference in display 
resolution and offset by a difference in 
RAM.
The A11 Bionic is 25% faster in single core 
and 80% faster in multicore scores than 
iPhone 7. This is particularly noteworthy 
because Apple’s latest chip delivers new 
neural net, camera ISP and GPU capabilities 
above and beyond what a generic processor 
benchmark measures. With more 
Augmented and Virtual Reality apps due to 
start arriving soon, thanks to Apple’s ARKit 
promotion, this performance will become 
ever more useful.

I guess this all begs the question ‘are we 
excited about iPhone 8 and X?’  
I don’t know if ‘excited’ is the right word 
for me, but that normally happens once 
an Apple expert talks me through a new 

device. These are very solid improvements, 
no doubt. I have always lauded Apple’s 
dedication to improving things and making 
them more useful. On that spectrum, these 
are pretty dramatic advances.
I’m really looking forward to a new iPhone 
for myself, for sure, and it’s not like me 
to imagine waiting another 12 months for 
something I really want and need, so we’ll 
see. For me, the 8 ticks all the boxes.
But do I understand the allure of the 
iPhone X model? I have to say no, for 
the same reason I don’t ‘get’ Porsches. 
They’re technically amazing, for sure, but 
you can’t drive them anywhere near their 
performance, so what’s the point? Apart 
from showing off. I’ve never been one to 
own things merely to show off, and to me 
so far, at it’s ridiculous price point, the X 
hints more of that.

I don’t believe this is just reverse-
snobbery, by the way. I like to use 
something to at least 50% of its 
capabilities. Driving a supercar on a New 
Zealand road, you’re getting 20% of its 
potential at best. Paying a premium to do 
that is very far away from common sense.
I feel the same way about an iPhone X. At 
least there are no speed limitations for it, 
but very few iPhone users will be pushing it 
to anywhere near its potential.
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> If  you’ve made the jump to iOS 11, here are some tips for youtips&tricks
1/  A Safari finger gesture opens links in 
the background Immediately — In iOS 
11 there is a way to open links immediately 
in the background while browsing Safari. 
You’ll need to go into Settings>Safari and 
turn on Open Links, and choose to open 
links in the background.
Now you can long-press the link, or 3D 
Touch the link. This lets you open web 
pages without navigating away from the 
current page. (This feature may have been 
around at least since iOS 10, and it works 
on iPhone and iPad).
(If you don’t have 3D Touch, 
try tapping the link with 
two fingers.)

2/ Using AirDrop in 
iOS 11 — The first, and 
arguably easiest, way to 
toggle AirDrop in iOS 11 is 
through the Control Center. 
Open the Control Center 
by swiping up from the 
bottom of the screen. The 
platter in the top left corner 
will show you Airplane 
mode, Wi-Fi, Bluetooth, and 
Cellular Data, if you have it 
on your iOS device.
If you long-press or 3D 
Touch deep press on that 

platter, it will open up a couple more 
options (left) for you. One of those is 
AirDrop, which you can just tap on.
Then, choose whether you want the feature 
off, available to everyone, or available to 
just your contacts.
If you prefer, you can also find the toggle 
for AirDrop in the Settings app. Open 
Settings -> General -> AirDrop.
Then you can find the same configurations 
for AirDrop as in Control Center: Everyone, 
Contacts Only, or Off.

3/ Focus Lock the 
iPhone’s default camera 
— The iPhone’s default 
camera app is good, but 
sometimes there are one 
or two features you’re 
looking for that it doesn’t 
have, such as locking 
the focus or shooting in 
RAW. But it turns out that 
you can focus lock the 
camera, it’s just hidden 
away behind a gesture. 
Focus lock means that the 
camera will stay focused 
on a certain object even 
when you move around. 
Here’s how to do it.
Locking the focus isn’t 

new in iOS 11, but since the user interface is 
different it’s time for a refresher. You may 
already know that when you’re taking a 
photo with the default camera app, you can 
tap on the screen to focus on something 
specific in your frame. Now, to focus lock, 
you have to press and hold anywhere you 
want to focus on for a second.
The yellow reticle will flash a couple of 
times, and it will lock onto the object until 
you close the app or tap on another part of 
the screen.
After you lock the focus you can tap on the 
sun icon and swipe up or down to control 
the exposure. Swiping down will darken the 
image and lower the intensity of highlights 
so you get more detail.

4/ Turn Photos into custom Apple Watch 
faces — You’ll need at least one photo, 
but you can use up to ten for your custom 
watch face. Open the Photos app on your 
iPhone to get started. Now do this:
Select a photo you want to use as your 
custom watch face. You can pick up to 10.
Tap the Share icon in the bottom left corner 
of the screen
Choose Create Watch Face from the Share 
locations
Tap the Share icon (left) then the watch 
face icon (right) to turn your photo into a 
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tips&tricks > and if  you’re still on iOS 10 ...

custom watch face. If you chose a single 
photo now you can set it as a Photos or 
Kaleidoscope watch face
Fine tune your custom watch face settings
Next, you can set where the time shows 
and if any complications are visible
Tap Add
Now head over to the Watch app to select 
your custom watch face
Now head over to the Watch app and 
select your new custom watch face. If you 
included multiple photos in your custom 
face they’ll change when you lift your 
watch.

5/ Customize taps for each of your 
AirPods — Take your AirPods out of their 
case (or just open it), launch your Settings 
app on your iPhone or iPad, and then touch 
Bluetooth.
Under that section, you should see your 
AirPods by name. Touch the “i” next to 
them first.
On the subsequent screen, there’s a 
“Double-Tap on AirPod” section, now 
separated into left and right.
So just touch the side you want to 
configure, and you’ll see your choices.
Tap the behaviour you want, go back to set 
up the opposite AirPod, and then you’ll see 
what you’ve chosen out on the previous 
Settings > Bluetooth > AirPods screen.

1/ Save a PDF to iCloud — If you can print 
a particular item in iOS 10, you can save it 
as a PDF. You can also share a newly created 
PDF through a message 
or an email.
First open any app you 
can print from. In this 
case, I’m using Safari, 
so I’ll start the printing 
process by tapping the 
Sharesheet icon (an 
upwards arrow in a 
rectangle – it’s circled in 
the image at left). Once 
the options screen opens, 
swipe to find Print along 
the bottom row of icons 
and once you tap that, 
you will see a preview of 
how my webpage would 
look if you printed it.
But here’s the hidden 
feature: place two fingers 
on the screen and pinch 
outwards to open on the little preview 
image and you will be taken to the PDF 
version of the item. Yet another Sharesheet 
allows you to save the PDF to iCloud Drive 
with an icon on the bottom row of the 
subsequent screen
You can also do the typical sharing stuff 
with your PDF: add it to a message or an 

email, or other options.
[From Melissa Holt at  Mac Observer.]

2/ In Notes on iPhone/
iPad, use an On My 
[Device] account — If 
you’re really concerned 
about the security of data 
you type into your notes, 
you should probably lock 
the important ones. Also, 
though, you can choose to 
store certain notes only 
on one device or another 
as opposed to syncing 
them all through iCloud. 
You could keep a list on 
your iPhone but not pull it 
onto the family iPad that’s 
signed into your iCloud 
account, for example.
Visit Settings on the 
device you’d like to store 
local notes on, and then 

go to the Notes section. At the bottom 
is a toggle for adding an On My [Device] 
account. Turn that on, and you can choose 
where to add any new notes by visiting the 
section in question from your main Notes 
window; for example, choose Notes under 
On My iPhone to create or edit anything 
that lives only on that one device.
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tips&tricks > iOS 10 tips continued, and some for macOS

3/ Stop; collaborate and listen — If you’re 
writing a note and look at the top of your 
screen, you’ll see a silhouette icon. Tap 
that, and your device’ll walk you through 
adding someone as a collaborator.
This means that anyone you add to that 
note will be able to see changes you make 
to it, which could be handy for all sorts of 
shared tasks. The only caveat is that you 
can only use this feature through iCloud, 
so you’ve gotta be logged in. (And if you 
need more info, check out Apple’s support 
article on this.)

4/ Save media you add to Notes — If you 
need to remember to buy or do something, 
taking a picture within a note is a good way 
to accomplish that. To do so, just tap on 
the little plus button within a note if you 
don’t see the toolbar then pick the camera 
icon to snap a picture.
The default means that none of those 
saved images and videos are added to your 
photo library, but if you’d like to switch that 
up, visit Settings> Notes and change that 
option. Afterward, the media you save in 
Notes will be saved in Photos, too.
(Within Settings> Notes, there’s also an 
option labelled New Notes Start With. If 
you’re not fond of your notes always having 
a big bold title or heading at the top, you 

can change that to ‘body’ and it’ll all just be 
regular text.)
[These Notes tips also came from Melissa 
Holt at Mac Observer.]

5/ Automatic reminders for events you 
set in Calendar — There’s no need to 
manually add a reminder to each and every 
meeting in your calendar. Instead, you can 
set the iOS Calendar app to automatically 
add a reminder for any new events you 
create. Tap Settings, choose Calendar, then 
tap the Default Alert Times setting.
Now select automatic alert times for up to 
three different types of Calendar events: 
birthdays, generic events and all-day 
events. For birthdays and all-day events, 
you can set a default alert anywhere from 
a week before to the morning of the event. 
For standard events, your auto-reminder 
choices range from a week before to the 
moment the event begins.
You can even add a Time to leave reminder 
that’ll let you know when to start 
commuting to an event, provided you’ve 
filled in the event’s Location field. Just 
enable the Time to Leave setting.
Back out of the Settings screen, head 
back to the Calendar app, and create a 
new event. When you do, you will see an 
alert already set up. [There are more iOS 
Calendar tips at Here’s The Thing.]

1/ Open Microsoft Office docs in macOS 
Sierra without Microsoft Office — If you 
need to open (or export Microsoft) Office 
docs in macOS Sierra, but don’t want to 
buy and install the massive Office suite, 
you can use Pages, Numbers, and Keynote 
to open and save docs created with 
Microsoft Office. Every new Mac has these 
apps o them already, for free. If not, Pages, 
Numbers, and Keynote are available from 
the Mac App Store.
To open a Microsoft Office doc, drag it 
from a folder or even from within an 
email, and drop it on the Pages icon in the 
Dock – when the Pages icon goes dark, 
release the mouse or trackpad and Pages 
will convert and open the file. For an Excel 
doc, drag it over the Numbers app in the 
Dock and let go; Powerpoint over Keynote.
To export Pages, Numbers or Keynote 
documents as Word, Excel or Powerpoint, 
say for someone on a PC who only has 
these apps, choose File>Export to and 
select the correct app from the pop-out. 
Easy.

2/ Put the iCloud Drive icon (and others) 
in your Dock — In  Finder, in the menu 
bar, click Go, then Go to Folder near the 
bottom.
A window will appear where you can copy 
and paste the following directory:
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/System/Library/CoreServices/Finder.app/
Contents/Applications/
Here you’ll see six different apps that 
represent some Mac’s services: AirDrop, 
All My Files, Computer, iCloud Drive, 
Network, 
Recents. You can 
drag and drop 
any of these into 
the dock.
Unfortunately, 
they aren’t 
dynamic app 
icons unlike 
most, including Pages, Numbers and 
Keynote as above, Mail and others: if you 
drag a file onto the AirDrop icon, it won’t 
automatically open AirDrop and find your 
devices. You can only click on them, so it’s 
basically just a shortcut to these services. 
But now you won’t have to open Finder 
first before you jump to these locations. 
Hopefully it will save you a few precious 
seconds in your workflow.

3/ Set the default wireless network in 
macOS Sierra — By default, macOS Sierra 
attempts to join the wireless network it 
was most recently connected to. However, 
if you have a Wi-Fi network you use 
most often, you can set it as the default 
network in macOS Sierra.

tips&tricks > macOS tips continued

The wireless networks your computer has 
connected to are listed in the Wi-Fi pane 
of Network preferences. You can set up 
your Mac to join a preferred network when 
you start your computer, wake it from 

sleep, or turn Wi-Fi on:
Choose Apple menu > System 
Preferences, then choose Network.
Click Wi-Fi in the list at the left, then 
click Advanced.
If Wi-Fi isn’t in the list, make sure your 
Mac has wireless capability, then click 
the Add button (a plus sign) at the 
bottom of the list. Click the Interface 

pop-up menu, choose Wi-Fi, give the 
service a name, then click Create.
Click Wi-Fi.
If the network you expect to see isn’t in 
the preferred networks list, click the Add 
button at the bottom of the list, then click 
Show Networks. Click the network you 
want to add to the list, then click Join. If 
the network is protected by a password, 
enter it.
Drag the the network you want to give 
highest priority to the top of the preferred 
networks list. This is the network your 
computer will try to join first.
(To delete a network from the list, select 
it, then click the Remove button – it’s the 
minus sign.)

4/ Hide All Day Events in Calendar 
— Apple has built in a way to hide 
all-day events, so you could use that to 
temporarily get more breathing room for 
your own scheduled items. 
To do so, you’ll just deselect Show All-Day 
Events under the View menu.

5/ Create your own keyboard shortcuts 
— Make note of any menu command 
you’d like a faster keyboard shortcut for, 
click on the Apple Menu, choose System 
Preferences and visit the Keyboard section. 
Here, click the Shortcuts tab and select 
App Shortcuts from the sidebar. That 
section has a plus button near the bottom, 
so if you click that, you can add your 
custom shortcut. 
In the first drop-down, choose the 
program you’re applying your shortcut to.
Then type in the command, indicating 
the menus and submenus it’s under 
with the ‘hyphen-greater than’ combo 
(shown above). Be sure to include any 
capitalisation and punctuation; if you need 
to type an ellipsis, the keyboard shortcut is 
Option-Semicolon.
Once you’re sure you have the command 
typed correctly, add in the Keyboard 
Shortcut field by just clicking within it 
and pressing your desired shortcut – for 
example, the Command key + Option + 
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tips&tricks > macOS continued, and some for iOS 10, iOS 11 and watchOS 3

9.  You’ll see your creation appear in the 
list after you click Add – your shortcut will 
also show up within the app you added it 
to.
Be sure, though, that the shortcut isn’t 
a duplicate of one already in use. If 
that’s the case, yours may not work, and 
you’ll have to come back here to System 
Preferences > Keyboard > Shortcuts > 
App Shortcuts and click on the original 
shortcut you created to press a new one.
(You may be able to add a custom 
keyboard shortcut without putting the 
menu hierarchy in (eg, using Show All-Day 
Events instead of View->Show All-Day 
Events), but doing so may mean that 
your shortcut acts flaky or stops working 
altogether. 
If you’ve got any more questions, feel free 
to check out Apple’s support article on 
this topic, as it’s fairly extensive. 
(From the Mac Observer).

1/  Selectively control Read Receipts for 
iMessage in iOS 10 — A read receipt in 
iMessage is simply a feature designed to 
let your contacts know when you’ve read 
their message. You can go into Settings 
to turn this on and off at will, but on iOS 
9 and before, this setting turned it off 
for all contacts. With iOS 10 however, 
it’s possible to control read receipts for 
each of your contacts if they also have 
iPhones (otherwise the option is simply 
not available). Now you can let your boss 
know when you’ve read her message, 
while turning the feature off for that weird 
guy you met on Tinder [to quote Mac 
Observer!].
Open up a message from one of your 
contacts. In the upper right part of the 
screen, tap the blue circle with an ‘i’. There 
you can share your location, see a history 
of images and attachments with that 
contact – and control read receipts.]

2/ Modify AirPods behaviour — Once 
iOS 11 ships, which may be as soon as 12th 
September, you will have more options. 
For now, in iOS 10, you can change how 
your AirPods react when you double-tap 
on them, or switch what happens when 
you put them in your ears. You adjust 
these options on your iPhone or iPad. To 
get started, open your AirPods’ case or 

take them out of it, 
then visit Settings > 
Bluetooth on your 
paired iOS device.
There you’ll see 
a list of all of the 
Bluetooth devices 
you’ve added. If you 
don’t see Connected 
next to your AirPods, 
tap their name to 
connect.
Within this option, 
you can disconnect your AirPods (or have 
your device forget them entirely), change 
their name, or set what happens when you 
double-tap one of them. This is probably 
the most useful adjustment, as you could 
configure your AirPods to play/pause 
instead of invoking Siri with a double-tap.
Also on this screen are Automatic Ear 
Detection, which you can turn off if you 
don’t like your audio automatically being 
sent to your AirPods when you put them 
in your ears—and the Microphone setting. 
This lets you configure which AirPod you’d 
like to always be your microphone.

3/ Using 3D Touch in Spotlight — With 
a recent iPhone (6s/6s Plus or 7/7 Plus), 
you’re probably accustomed to your 
favourite uses for 3D Touch: looking at 
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tips&tricks > More iOS tips and one for watchOS

notifications within folders, opening new 
private tabs in Safari etc. You can also use 
Spotlight searches to find apps, and then if 
you press on a result within the Spotlight 
interface, you’ll get the same options 
you’d get by 3D-touching the app itself.
Start by swiping down on your home 
screen to open the iOS Spotlight search 
function, then type the name of an app 
into the search field at the top. Press with 
a little force on the app in the results to 
get the same Quick Action choices you 
would get from using 3D Touch on the app 
icon on the Home screen. You can use this, 
for example, to quickly find the Camera 
app and use its Quick Actions.

4/ In iOS 11, set up and customise Do 
Not Disturb While Driving — For those 
already beta-testing the next generation 
of iOS, you can do this now For the rest, 
you can do this soon. iOS 11 will add Do 
Not Disturb support for driving so you 
won’t get distracted while you’re cruising 
around town. You don’t have to use it, but 
if you do, it’s easy to set up and customise. 
Once iOS 11 is installed on your iPhone 
there’s a good chance you’ll get a dialogue 
asking if you want to turn on DND when 
you’re driving. The dialogue will pop up 
after you move off in your car.
Just tap Turn On While Driving and you’re 

set. Your iPhone will automatically go 
into DND mode when you’re in a moving 
car – it then mutes all incoming calls. 
You also won’t see other alerts and 
notifications while your car is in motion. 
(Of course, it won’t know if you’re driving 
or a passenger.)
DND While Driving can activate 
automatically when connected to your 
car’s Bluetooth, or manually. If you choose 
Manually, you will need to use the Do 
Not Disturb button in Control Center to 
activate the feature.
DND While Driving can auto-reply to text 
messages too. It’s your business who gets 
those messages, so you can change the 
settings and make your own custom reply:
Launch Settings on your iPhone
Tap Do Not Disturb
Choose Auto-Reply To
Select No One, Recents, Favorites, or All 
Contacts.
If you set your auto-reply to Favorites, it 
only goes to those people you’re in contact 
most. 
If you don’t want anyone to know when 
you’re in the car, choose No One.
To set an auto-reply, launch Settings on 
your iPhone
Tap Do Not Disturb
Choose Auto-Reply
Now enter a custom reply message.

5/ How to tell if Apple Watch 
notifications are from a native app or an 
iPhone app — Sometimes when you get a 
notification on your Apple Watch, you can 
tap on it for further options, or to open a 
corresponding app. At other times, that 
notification is from your iPhone, and all 
you can do is dismiss it.
The difference is in the shape. App icons 
on watchOS are circles, and when you get 
a notification from an app that is native 
to Apple Watch, tapping on it opens the 
corresponding app. 
When an alert arrives, or you are browsing 
through past ones in Notification Center, 
the corresponding app icon is located at 
upper left. If it’s a circle, tapping once 
provides quick options like Reply or 
Dismiss, and tapping a second time opens 
the corresponding app.
But if the icon is a rounded-corner square, 
it’s an iPhone notification.
There aren’t as many options for dealing 
with notifications not from native 
watchOS apps. Tap and you’ll have an 
option to dismiss, with no second tap to 
open the app, since the app is only on your 
iPhone. 
This subtle distinction of round or square 
is an easy way to tell what you can do 
directly from your wrist, without the need 
to pull your phone out.
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shiny&new

Kensington SD5000T Dock
I recently reviewed this handsome unit 
which has an unexpected design benefit in 
that the dished top becomes a handy pen 
& paperclip receptacle. This Thunderbolt 
3 dock has an indispensable array of 
ports. The fact it charges even a 2017 
MacBook Pro 15-inch is very handy. On 
the front: USB 3 (not 3.1, which is USB-C 
speed anyway) with 2.1A charging and 
an additional USB-C port. On the back, 
left to right, we have the all-important 
Ethernet, USB 3, Audio In, Audio Out, 
the Kensington lock slot (in the middle), 
2xUSB-C (one of these needs to go into 
your Mac via the short cable supplied), 
DisplayPort and AC power.
Kensington SD5000T Dock,  
NZ RRP $520 (US$349.99) 

> Kensington and Belkin USB-C Docks, Nanoleaf smart lights

>
>

Belkin Thunderbolt 3 Express
Belkin’s is in a more traditional silver. This 
is in the same case as Belkin’s Thunderbolt 
and Thunderbolt 2 docks. Four rubberised 
feet stop it sliding across your desk. 
This also has two ports on the front: USB 
3, plus a dual in-out stereo minipin. 
Across the back, this has Gigabit Ethernet, 
Audio out, 2x USB 3, 2x Thunderbolt 3/
USB-C, DisplayPort (it supports one 5K 
display or two 4K displays) and the DC 
power inlet.  
Like the SD5000T, the single USB-C cable 
supports video, data transfer at up to 40 
Gbps plus charges a MacBook Pro (85w). 
The connecting cable is supplied (a handy 
metre long) which takes up one of the two 
Thunderbolt 3 ports. The USB 3 ports only 
support 1.5A device charging, but also runs 
keyboards, mice, Flash and hard drives. 
Full review soon on Mac NZ.
Belkin Thunderbolt 3 Express Dock HD, 
NZ RRP $559 (US$349) 

Nanoleaf  Aurora
From Toronto, Canada, these smart lights 
via MacGear in NZ let you integrate the 
panels into your HomeKit system or 
just run them from your iPhone or iPad. 
Featuring a clever interlocking electrical 
PCB tab that lets you quickly attach any 
of the three sides to another panel, and 
then the power supply to any spare slot, 
this 9-panel starter pack lets you create 
several shapes from the get-go. Virtually 
‘paint’ individual panels or let effects 
sweep through, and of course brighten and 
dim, wow, these can be oh-so-subtle or 
party-garish at the touch on the free iOS 
app interface. Full review soon on Mac NZ.
Nanoleaf Aurora, NZ RRP $339.99
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